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1. Related Manuals 
 
The table below lists the manuals related to this document.  
To ensure system safety, make sure to always read and heed the information provided in all 
Safety Precautions and Precautions for Safe Use of manuals for each device which is used in 
the system.  
 

Cat. No. Model Manual name 
W500 NJ501-[][][][] 

NJ301-[][][][] 
NJ-series CPU Unit Hardware User's Manual 

W501 NJ501-[][][][] 
NJ301-[][][][] 

NJ-series CPU Unit Software User's Manual 

W505 NJ501-[][][][] 
NJ301-[][][][] 

NJ-series CPU Unit Built-in EtherCAT(R) Port  
User's Manual 

W504 SYSMAC-SE2[][][] Sysmac Studio Version 1 Operation Manual 
HMSI-168-95 AB7061 User Manual Anybus (R) CommunicatorTM for 

EtherCAT 
SP0991 AB7061 Anybus Communicator-EtherCAT Interface  

Installation Sheet 
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2. Terms and Definitions 
 

Term Explanation and Definition 
PDO Communications 
(Communications using 
Process Data Objects) 

This method is used for cyclic data exchange between the 
master unit and the slave units.  
PDO data (i.e., I/O data that is mapped to PDOs) that is 
allocated in advance is refreshed periodically each EtherCAT 
process data communications cycle (i.e., the period of primary 
periodic task).  
The NJ-series Machine Automation Controller uses the PDO 
Communications for commands to refresh I/O data in a fixed 
control period, including I/O data for EtherCAT Slave Units, and 
the position control data for the Servomotors.  
It is accessed from the NJ-series Machine Automation 
Controller in the following ways.  
・With device variables for EtherCAT slave I/O 
・With Axis Variables for Servo Drive and encoder input slave to 

which assigned as an axis 
SDO Communications 
(Communications using 
Service Data Objects) 

This method is used to read and write the specified slave unit 
data from the master unit when required.  
The NJ-series Machine Automation Controller uses SDO 
Communications for commands to read and write data, such as 
for parameter transfers, at specified times.  
The NJ-series Machine Automation Controller can read/write 
the specified slave data (parameters and error information, etc.) 
with the EC_CoESDORead (Read CoE SDO) instruction or the 
EC_CoESDOWrite (Write CoE SDO) instruction.  

Slave unit There are various types of slaves such as Servo Drives that 
handle position data and I/O terminals that handle the bit 
signals.  
The slave unit receives output data sent from the master, and 
sends input data to the master.  

Node address A node address is an address to identify a unit connected to 
EtherCAT.  

ESI file 
(EtherCAT Slave  
Information file) 

The ESI files contain information unique to the EtherCAT slaves 
in XML format.  
Installing an ESI file enables the Sysmac Studio to allocate 
slave process data and make other settings.  
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3. Precautions 
 
(1) Understand the specifications of devices which are used in the system. Allow some 

margin for ratings and performance. Provide safety measures, such as installing safety 
circuit in order to ensure safety and minimize risks of abnormal occurrence.  

(2) To ensure system safety, make sure to always read and heed the information provided in 
all Safety Precautions and Precautions for Safe Use of manuals for each device which is 
used in the system.  

(3) The user is encouraged to confirm the standards and regulations that the system must 
conform to.  

(4) It is prohibited to copy, to reproduce, and to distribute a part or the whole of this 
document without the permission of OMRON Corporation.  

(5) The information contained in this document is current as of September 2014. It is subject 
to change without notice for improvement.  

 
The following notations are used in this document.  

 

Indicates a potentially hazardous situation which, if not 
avoided, will result in minor or moderate injury, or may 
result in serious injury or death. Additionally there may 
be significant property damage. 

 

 

Indicates a potentially hazardous situation which, if not 
avoided, may result in minor or moderate injury or 
property damage. 

 

 Precautions for Correct Use 

Precautions on what to do and what not to do to ensure proper operation and performance.  

 

 Additional Information 
Additional information to read as required.  
This information is provided to increase understanding or make operation easier.  

 
Symbol 
  

 

The filled circle symbol indicates operations that you must do. 
The specific operation is shown in the circle and explained in text. 
This example shows a general precaution for something that you must do. 
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4. Overview 
 
This document describes the procedure for connecting Anybus Communicator for EtherCAT 
Slave (hereinafter referred to as Communicator) of HMS Industrial Networks (hereinafter 
referred to as HMS) to NJ-series Machine Automation Controller (hereinafter referred to as 
Controller) of OMRON Corporation (hereinafter referred to as OMRON) via EtherCAT and 
provides the procedure for checking their connection 
Refer to Section 6. EtherCAT Settings and Section 7. EtherCAT Connection Procedure to 
understand the setting method and key points to operate PDO Communications of EtherCAT.  
 
 

5. Applicable Devices and Device Configuration 
 

5.1. Applicable Devices 
The applicable devices are as follows: 
 

Manufacturer Name Model 
OMRON NJ-series CPU Unit NJ501-[][][][] 

NJ301-[][][][] 
HMS Anybus Communicator for EtherCAT Slave AB7061 

 

 Precautions for Correct Use 

As applicable devices above, the devices with the models and versions listed in Section 5.2. 
are actually used in this document to describe the procedure for connecting devices and 
checking the connection.  
You cannot use devices with versions lower than the versions listed in Section 5.2.  
To use the above devices with versions not listed in Section 5.2. or versions higher than those 
listed in Section 5.2., check the differences in the specifications by referring to the manuals 
before operating the devices.  

 

 
Additional Information 
This document describes the procedure to establish the network connection. Except for the 
connection procedure, it does not provide information on operation, installation or wiring 
method. It also does not describe the functionality or operation of the devices.  
Refer to the manuals or contact the device manufacturer.  
(HMS Industrial Networks http://www.hms.se/) 
This URL is the latest address at the time of this document creation.  
Contact each device manufacturer for the latest information.  
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5.2. Device Configuration 
The hardware components to reproduce the connection procedure of this document are as 
follows: 
 
 
 
 
 
 
 
 
 
 
 

Manufacturer Name Model Version 
OMRON CPU Unit 

(Built-in EtherCAT port) 
NJ501-1500 Ver.1.08 

OMRON Power Supply Unit NJ-PA3001  
OMRON Sysmac Studio SYSMAC-SE2[][][] Ver.1.09 
- Personal computer  

(OS: Windows 7) 
-  

- USB cable  
(USB 2.0 type B connector) 

-  

OMRON Ethernet cable (with industrial 
Ethernet connector) 

XS5W-T421-[]M[]-K  

HMS Anybus Communicator 
for EtherCAT Slave 

AB7061 Ver.3.01 

HMS Dedicated RS-232C cable (Included with 
Communicator) 

 

HMS ESI file XML_ABC_ECT_V_3_01_
Fixed_PDO_256bytes_for
_OMRON_1.xml 

 

HMS Anybus Configuration Manager- 
Communicator RS232/422/485 

ACM Communicator 
RS232/422/485 

Ver.4.3.1.1 

- 24 VDC power supply -  

 

 Precautions for Correct Use 

Prepare the ESI file shown in this section beforehand. The ESI file can be downloaded from 
HMS Industrial Networks website. 

(HMS Industrial Networks  http://www.hms.se/) 
Contact HMS Industrial Networks if the file is not available. 

 
  

Ethernet cable 

AB7061 

Dedicated RS-232C cable 

USB cable 

Personal computer 
(Sysmac Studio and  
Anybus Configuration Manager- 
Communicator RS232/422/485  
installed. 
OS:Windows 7) 

NJ501-1500 
(Built-in EtherCAT port) 

24 VDC power supply 
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 Precautions for Correct Use 

The connection line of EtherCAT communications cannot be shared with other Ethernet 
networks. Do not use devices for Ethernet such as a switching hub.  
Use the Ethernet cable (double shielding with aluminum tape and braiding) of Category 5 or 
higher, and use the shielded connector of Category 5 or higher.  
Connect the cable shield to the connector hood at both ends of the cable.  

 

 Precautions for Correct Use 

Update the Sysmac Studio to the version specified in this section or higher version using the 
auto update function.  
If a version not specified in this section is used, the procedures described in Section 7 and 
subsequent sections may not be applicable. In that case, use the equivalent procedures 
described in the Sysmac Studio Version 1 Operation Manual (Cat. No. W504).  

 

 Additional Information 
For information on the specifications of the Ethernet cable and network wiring, refer to 
Section 4. EtherCAT Network Wiring of the NJ-series CPU Unit Built-in EtherCAT(R) Port 
User's Manual (Cat. No. W505).  

 

 Additional Information 
The system configuration in this document uses USB for the connection to the Controller.  
For information on how to install a USB driver, refer to A-1 Driver Installation for Direct USB 
Cable Connection of the Sysmac Studio Version 1 Operation Manual (Cat. No. W504).  
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6. EtherCAT Settings 
 
This section describes the specifications such as parameters and device variables that are set 
in this document. 
Hereinafter, the Communicator is referred as ''Destination Device'' or the "Slave Unit" in some 
descriptions. 
 

 Precautions for Correct Use 

Note that in this document communications between the Controller and Communicator are 
checked; however, no communications data after establishing the EtherCAT communications 
is checked. 

 
 

6.1. Parameter Settings 
The parameters required connecting the Controller and the Communicator via EtherCAT are 
given below. 
 

Name Setting item Set value Remarks 
Communicator Node address 1 The actual node 

address is set by 
Sysmac Studio. 

Fieldbus Type EtherCAT - 

Protocol Mode Generic Data mode - 

Producer Maximum 
Data Length 

256 Byte - 

Consumer Maximum 
Data Length 

256 Byte - 

 

 Additional Information 
For details on EtherCAT-related parameters for Communicator, refer to 2.4. EtherCAT 
Communication Properties of the User Manual Anybus (R) CommunicatorTM for EtherCAT 
(Cat. No. HMSI-168-95).  
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6.2. Device Variables 
The PDO communications data for the Destination Device are allocated to the Controller's 
device variables.  
The device variables and the data types are shown below.  
 
■ Output area (from Controller to Destination Device) 

Device variable name Data type Meaning 
E001_Recieve_PDO_1_Mapping_Output
_Byte_1_2100_01 USINT Output byte 0000 

・ 
・ 
・ 

・ 
・ 
・ 

・ 
・ 
・ 

E001_Recieve_PDO_1_Mapping_Output
_Byte_128_2100_80 USINT Output byte 0127 

E001_Recieve_PDO_2_Mapping_Output
_Byte_1_2101_01 USINT Output byte 0128 

・ 
・ 
・ 

・ 
・ 
・ 

・ 
・ 
・ 

E001_Recieve_PDO_2_Mapping_Output
_Byte_128_2101_80 USINT Output byte 0255 

 
■ Input area (from Destination Device to Controller) 

Device variable name Data type Meaning 
E001_Transmit_PDO_1_Mapping_Input_
Byte_1_2000_01 USINT Input byte 0000 

・ 
・ 
・ 

・ 
・ 
・ 

・ 
・ 
・ 

E001_Transmit_PDO_1_Mapping_Input_
Byte_128_2000_80 USINT Input byte 0127 

E001_Transmit_PDO_2_Mapping_Input_
Byte_1_2001_01 USINT Input byte 0128 

・ 
・ 
・ 

・ 
・ 
・ 

・ 
・ 
・ 

E001_Transmit_PDO_2_Mapping_Input_
Byte_128_2001_80 USINT Input byte 0255 

 

 Additional Information 
For details on I/O formats, refer to Section 3. CANopen Object Dictionary Implementation of 
the User Manual Anybus (R) CommunicatorTM for EtherCAT (Cat. No. HMSI-168-95).  

 

 Additional Information 
The device variables are named automatically from a combination of the device names and 
the port names.  
The default device names are “E" followed by a serial number that starts from 001.  
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7. EtherCAT Connection Procedure 
 
This section describes the procedure for connecting the Controller to the Communicator via 
EtherCAT. 
This document explains the procedures for setting up the Controller and the Communicator 
from the factory default setting. For the initialization, refer to Section 8. Initialization Method.  
 

7.1. Work Flow 
Take the following steps to perform PDO Communications of EtherCAT.  
 

7.2. Setting Up HMS Communicator  Set up HMS Communicator.  
↓   

 7.2.1. Hardware Settings  Connect a cable to the Communicator. 
↓   

 7.2.2. Parameter Settings  Set the parameters for the Communicator.  
↓   

7.3. Setting Up the Controller  Set up the Controller.  
↓   

 7.3.1. Starting the Sysmac Studio and 
Installing the ESI File 

 Install the ESI file for the Communicator in the 
Sysmac Studio.  

↓   
 7.3.2. Setting Up the EtherCAT 

Network Configuration 
 Set up the EtherCAT network configuration.  

↓   
 7.3.3. Setting the Device Variables  Set the device variables used for the EtherCAT 

Slave Unit.  
↓   

 7.3.4. Transferring the Project Data  Transfer the project data from the Sysmac Studio to 
the Controller.  

↓   
7.4. Checking the EtherCAT 

Communications 
 Confirm that the PDO Communications of EtherCAT 

are performed normally.  
↓   

 7.4.1. Checking the Connection Status  Check the connection status of the EtherCAT 
network.  
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7.2. Setting Up HMS Communicator 
Set up HMS Communicator.  

 
7.2.1. Hardware Settings 

Connect a cable to the Communicator.  
 

 Precautions for Correct Use 

Make sure that the power supply is OFF when you perform the setting up.  

 

1 Make sure that the power supply 
to the Communicator is OFF. 
 
*If the power supply is turned 
ON, settings may not be 
applicable as described in the 
following procedures.  

 

2 Check the position of the 
connectors on the 
Communicator by referring to 
the right figure. 

 
 
 
            A: EtherCAT Port 1 (In) 
            B: EtherCAT Port 2 (Out) 
            C: Status LEDs 
            D: PC-connector 
            E: Subnetwork Connector 
            F: Power Connector 
 
 
 

3 Connect the Ethernet cable to 
the EtherCAT port 1 (In). 

 

Ethernet cable 
EtherCAT port 1 (In) 
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4 Connect the PC-connector and 
the Personal computer with the 
Dedicated RS-232C cable. 

 

5 Connect the 24 VDC power 
supply to the Power connector. 
 
*For details on power supply 
wirings, refer to the User 
Manual Anybus (R) 
CommunicatorTM for EtherCAT 
(Cat. No. HMSI-168-95).  

6 Turn ON the 24 VDC power 
supply.  

 

  

Dedicated 
RS-232C cable 

PC-connector Personal 
computer 

Power 
connector 

24 VDC 
power supply 
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7.2.2. Parameter Settings 
Set the parameters for the Communicator.  
Install the Anybus Configuration Manager-Communicator RS232/422/485 in the Personal 
computer beforehand to set parameters. 
 

 Additional Information 
For how to install the software, refer to the User Manual Anybus (R) CommunicatorTM for 
EtherCAT (Cat. No HMSI-168-95). 

 

1 Start the Anybus Configuration 
Manager-Communicator 
RS232/422/485. 

 

2 The Anybus Configuration 
Manager Dialog Box is 
displayed as shown in the right 
figure. 

 

3 Select Blank Configuration on 
the Select Configuration Dialog 
Box and click the OK Button. 
  
The Select Configuration Dialog 
Box is automatically closed.  
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4 Click Communicator 
RS232/422/485 in Devices: that 
is shown on the left side of the 
Anybus Configuration Manager 
Dialog Box.  
 
 
 
 
The Configuration Pane that is 
shown on the right side of the 
Anybus Configuration Manager 
Dialog Box changes as shown 
on the right.  

 
 

 

5 Select Generic Data Mode from 
the pull-down list of the Protocol 
Mode in the Configuration Pane. 
 
 
 
 
 
 
 
 
 
Check that Protocol Mode is set 
to Generic Data Mode. 
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6 Click Fieldbus in Devices: that 
is shown on the left side of the 
Anybus Configuration Manager 
Dialog Box.  
 
 
 
 
 
The Configuration Pane that is 
shown on the right side of the 
Anybus Configuration Manager 
Dialog Box changes as shown 
on the right.  

 
 

 

7 Select EtherCAT from the 
pull-down list of the Fieldbus 
Type in the Configuration Pane. 
 
 
 
 
 
 
Check that Filedbus Type is set 
to EtherCAT. 
Check that IO Sizes is set to 
Automatic. 
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8 Click + Button to open 
Subnetwork in Devices. 
 
Right-click New Node and 
select Add Transaction 
Produce.  
 
 
 
 
 
Check that Produce 1 is added 
to Devices. 

 
 

 

9 Right-click Produce 1 and 
select Add Variable Data.  
 
 
 
 
 
 
 
 
 
 
Check that VariableDataObject 
is added to Devices. 
 
 
 
 
Set Maximum Data length to 
0x0100 in the Configuration 
Pane. 
 
*The total size of the data on 
EtherCAT is 256 bytes, which 
includes the size of Control 
Word. 

 
*Control Word is set to Disable 
by default.  
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10 Right-click New Node and 
select Add Transaction 
Consume.  
 
 
 
 
 
 
Check that Consume 1 is added 
to Devices. 

 
 

 

11 Right-click Consume 1 and 
select Add Variable Data.  
 
 
 
 
 
 
 
 
 
 
Check that VariableDataObject 
is added to Devices. 
 
 
 
 
 
Set Maximum Data length to 
0x0100 in the Configuration 
Pane. 
 
*The total size of the data on 
EtherCAT is 256 bytes, which 
includes the size of Status 
Word.  

 
*Status Word is set to Disable by 
default.  
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12 Select Port from the Tools 
Menu. Check that the port No., 
where the Communicator is 
connected, is selected. 
 
*If there are multiple serial ports 
on the Personal computer, 
display the Windows Device 
Manager. Then select the 
same port as the 
communications port No. 
where the Communicator is 
connected under Ports (COM & 
LPT)(COM1 in this example). 

 
*To display the Device Manager, 
right-click Computer, select 
Properties, and then click 
Device Manager. 

 

 

 

13 Select Communicator 
RS232/422/485 in Devices. 
 
 
 
 
 
 
 
 
 
 
 
 
Communicator RS232/422/485 
is added to the menu. 

 

 

 

14 Select Connect from the 
Communicator RS232/422/485 
Menu. 
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15 Config Line shown on the right 
bottom of the window is lit 
green.  

 

16 Select Download 
configuration to 
Communicator RS232/422/485 
from the Tools Menu. 

 

17 The Name the Configuration 
Dialog Box is displayed.  
Check the contents and click the 
OK Button. 
 
 
 
 
 
 
 
 
 
 
The Download Dialog Box is 
displayed and download is 
executed. When the download is 
complete, the dialog box is 
closed. 
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7.3. Setting Up the Controller 
Set up the Controller.  
 

7.3.1. Starting the Sysmac Studio and Installing the ESI File 
Install the ESI file for the Communicator in the Sysmac Studio.  
Install the Sysmac Studio and USB driver in the Personal computer beforehand.  
 

1 Connect the Ethernet cable to 
the built-in EtherCAT port 
(PORT2) of the Controller and 
connect the USB cable to the 
peripheral (USB) port. As shown 
in 5.2. Device Configuration, 
connect the Personal computer, 
the Destination Device, and the 
Controller.  

 

2 Turn ON the power supply to the 
Controller.  

 

3 Start the Sysmac Studio.  
 
*If a confirmation dialog for an 
access right is displayed at 
start, execute a selection to 
start.  

 

4 The Sysmac Studio starts.  
Click the Connect to Controller 
Button.  

 

5 The Connect to Controller 
Dialog Box is displayed.  
Select the Direct connection via 
USB Option of Connection type.  
Uncheck both the Upload the 
project Check Box and the 
Display the Troubleshooting 
Dialog Box Check Box of 
Operation after Connection.  
 
Click the Connect Button.  

 

 

USB cable End Cover 

Power Supply Unit 
Ethernet 
cable 

CPU Unit 
Controller 

Personal 
computer 

Destination 
Device 



7．EtherCAT Connection Procedure 

 20 

6 Check the contents and click the 
OK Button if a confirmation 
dialog box on the right is 
displayed.  
 
*The displayed dialog depends 
on the status of the Controller 
used. Check the contents and 
click the OK or Yes Button to 
proceed with the processing.  

 

 

7 A dialog box on the right is 
displayed. Check the contents 
and click the OK Button.  

 

8 The Auto Connect Project 
Dialog Box is displayed online.  
When an online connection is 
established, a yellow bar is 
displayed on the top of the Edit 
Pane.  
 
This window consists of the 
following panes.  
Left: Multiview Explorer 

Top right: Toolbox 

Bottom right: Controller Status Pane 

Middle top: Edit Pane 

The following tab pages are 
displayed at the middle bottom 
of the window.  
Output Tab Page 

Build Tab Page 

Watch Tab Page (Project) 

 

 

 

 Additional Information 
For details on online connections to a Controller, refer to Section 6. Online Connections to a 
Controller of the Sysmac Studio Version 1 Operation Manual (Cat. No. W504).  

 

9 Double-click EtherCAT under 
Configurations and Setup in 
the Multiview Explorer.  

 

Controller 
Status Pane 

Toolbox 

Multiview 
Explorer 

Edit Pane 

Watch Tab Page 
(Project) 

Build Tab 
Page 

Output Tab 
Page 
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10 The EtherCAT Tab Page is 
displayed in the Edit Pane.  

 

11 Right-click Master and select 
Display ESI Library.  

 

12 The ESI Library Dialog Box is 
displayed. Click the this folder 
link.  
 
When the Explorer starts, close 
the dialog box by clicking the 
Close Button.  

 

13 The Explorer starts and a folder 
for installing the ESI fine is 
opened. Copy the prepared ESI 
file 
XML_ABC_ECT_V_3_01_Fixed
_PDO_256bytes_for_OMRON_
1.xml to this folder. 
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14 Select Exit from the File Menu 
to exit the Sysmac Studio.  
 
* After installing the ESI file, the 
Sysmac Studio needs to be 
restarted.  

 
 
 
 
 
 
A dialog box is displayed 
confirming whether to save the 
project. If you do not need to 
save it, click the No Button.  

 

 

15 In the same way as steps 3 to 
11, restart the Sysmac Studio 
and display the ESI Library 
Dialog Box.  
Click the + Button of 
XML_ABC_ECT_V_3_01_Fixed
_PDO_256bytes_for_OMRON_
1 to confirm that the Anybus 
Communicator - Slave 
Rev:0x00030001 device is 
displayed. 
 
Confirm that an exclamation 
mark (warning) is not displayed.  
 
Click the Close Button. 

 

 

 Precautions for Correct Use 

If an exclamation mark (warning) is displayed for the ESI file, check the name of the ESI file 
and obtain the ESI file with a correct name. If an exclamation mark (warning) is displayed 
even when the name of the ESI file is correct, the file may be corrupted.  
Contact the device manufacturer.  
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7.3.2. Setting Up the EtherCAT Network Configuration 
Set up the EtherCAT network configuration.  
 

 

Cycle the power supply to the Slave Unit in step 6. Always confirm safety before 
you cycle the power supply. 

 

 

1 Right-click Master on the 
EtherCAT Tab Page of the Edit 
Pane, and select Write Slave 
Node Address.  
 
*If the EtherCAT Tab Page is not 
displayed on the Edit Pane, 
take step 9 in 7.3.1. Starting 
the Sysmac Studio and 
Installing the ESI file to display.  

 
 
 
 
 
A screen is displayed stating 
"Get information is being 
executed". 

 
 

 

2 The Slave Node Address Writing 
Dialog Box is displayed.  
Anybus Communicator - Slave 
Rev:0x00030001 is displayed in 
the Actual network 
configuration. 
 
*If the present value of the node 
address is 0, an  error is 
displayed.  

 

3 Enter 1 in the Set value Field for 
a node address.  
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4 Confirm that no error is 
displayed and the set value is 1.  
Click the Write Button.  

 

5 The Slave Node Address Writing 
Dialog Box is displayed. Check 
the contents and click the Write 
Button. 
 
A screen is displayed stating 
"Slave Node Address Writing is 
being executed". 
 
 
 
The dialog box on the right is 
displayed. Check the contents 
and click the Close Button.  

 
 

 
 

 

6 Cycle the power supply to the 
Slave Unit.  

 

7 Right-click Master on the 
EtherCAT Tab Page, and select 
Compare and Merge with 
Actual Network Configuration.  
 
 
 
 
 
 
 
 
 
A screen is displayed stating 
"Get information is being 
executed". 
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8 The Compare and Merge with 
Actual Network Configuration 
Dialog Box is displayed.  
Node address 1 and Anybus 
Communicator - Slave 
Rev:0x00030001 are added to 
the Actual network configuration 
after the comparison. 
 
Click the Apply actual network 
configuration Button.  

 

9 A confirmation dialog box is 
displayed. Check the contents 
and click the Apply Button.  
 
The dialog box on the right is 
displayed. Click the Close 
Button.  

 
 

 

10 Node address 1, E001 and 
Anybus Communicator - Slave 
Rev:0x00030001 are added to 
the Network configuration on 
Sysmac Studio. 
 
Confirm that the data above are 
added, and click the Close 
Button.  

 

 

 

11 Node address 1, E001, and 
Anybus Communicator - Slave 
Rev:0x00030001 slave are 
added to the EtherCAT Tab 
Page on the Edit Pane.  
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7.3.3. Setting the Device Variables 
Set the device variables used for the EtherCAT Slave Unit.  

 

1 Select Offline from the 
Controller Menu.  
 
 
 
 
 
The yellow bar on the top 
disappears.  

 
 

 

2 Select Anybus Communicator 
added in the previous section on 
the EtherCAT Tab Page. 
Confirm that the Device name is 
E001.  
 
*Device name can be changed 
as desired.  

 

3 Double-click I/O Map under 
Configurations and Setup in 
the Multiview Explorer.  

 

4 The I/O Map Tab Page is 
displayed on the Edit Pane.  
Confirm that Node1 is displayed 
in the Position Column and the 
Slave Unit added in the Port 
Column is displayed.  
 
*To manually set a variable 
name for the Slave Unit, click a 
column under the Variable 
Column and enter a name.  

 

5 Right-click Node1 and select 
Create Device Variable.  
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6 The variable names and 
variable types are set.  

 

 

 Additional Information 
The device variables are named automatically from a combination of the device names and 
the port names.  
The default device names are “E" followed by a serial number that starts from 001.  

 

 Additional Information 
In this document, device variables are automatically named for a unit (a slave).  
Device variables can also be manually named for ports.  
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7.3.4. Transferring the Project Data 
Transfer the project data from the Sysmac Studio to the Controller.  

 

 
Always confirm safety at the Destination Device before you transfer a user 
program, configuration data, setup data, device variables, or values in memory 
used for CJ-series Units from the Sysmac Studio.  
The devices or machines may perform unexpected operation regardless of the 
operating mode of the CPU Unit.  

 

 

 
After you transfer the user program, the CPU Unit restarts and communications 
with the EtherCAT slaves are cut off. During that period, the slave outputs 
behave according to the slave settings. The time that communications are cut off 
depends on the EtherCAT network configuration.  
Before you transfer the user program, confirm that it will not adversely affect the 
device.  

 

 

 

A slave will be reset after performing the synchronization in step 7 and 
subsequent steps. Always confirm safety before performing the synchronization.  

 

 
 

1 Select Check All Programs 
from the Project Menu.  

 

2 The Build Tab Page is displayed.  
Confirm that "0 Errors" and "0 
Warnings" are displayed.  

 

3 Select Rebuild Controller from 
the Project Menu.  
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4 A confirmation dialog box on the 
right is displayed. Confirm that 
there is no problem and click the 
Yes Button.  

 

5 Confirm that "0 Errors" and "0 
Warnings" are displayed in the 
Build Tab Page.  

 

6 Select Online from the 
Controller Menu.  

 
 

 

7 Select Synchronization from 
the Controller Menu.  

 

8 The Synchronization Dialog Box 
is displayed.  
Confirm that the data to transfer 
(NJ501 in the right dialog box) is 
selected. Then, click the 
Transfer To Controller Button.  
 
*After executing the Transfer To 
Controller, the Sysmac Studio 
data is transferred to the 
Controller and the data is 
compared.   
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9 A confirmation dialog box on the 
right is displayed. Confirm that 
there is no problem and click the 
Yes Button.  
 
A screen stating "Synchronizing" 
is displayed.  
 
A confirmation dialog box on the 
right is displayed. Confirm that 
there is no problem and click the 
No Button.  
 
*Do not return to RUN mode.  

 
 

 
 

 

10 Confirm that the synchronized 
data is displayed with the color 
specified by "Synchronized" 
and that a message is displayed 
stating "The synchronization 
process successfully finished". 
If there is no problem, click the 
Close Button.  
 
*A message stating "The 
synchronization process 
successfully finished" is 
displayed if the Sysmac Studio 
project data and the data in the 
Controller match each other.  

 
*If the synchronization fails, 
check the wiring and repeat 
from step 1.  
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7.4. Checking the EtherCAT Communications 
Confirm that the PDO Communications of EtherCAT are performed normally.  
 

7.4.1. Checking the Connection Status 
Check the connection status of the EtherCAT network.  
 

1 Confirm that PDO Communications 
via EtherCAT are performed 
normally by checking the LED 
indicators on the Controller.  
 
The LED indicators in normal status 
are as follows: 

NET RUN: Green lit 
NET ERR: Not lit 
LINK/ACT: Yellow flashing 

 
 
 
 

 

2 Check the LED indicators on the 
Communicator.  
 
The LED indicators in normal status 
are as follows:  

[LED 1]: Green lit 
[LED 2]: Not lit 
[LED 3]: Green flickering 
[LED 4]: Not lit 
[LED 5]: Red lit 
[LED 6]: Green flashing 

 
*LED 5 is lit red because no device 
is connected to Subnetwork 
Connector in the procedure of this 
document. It does not affect 
EtherCAT communications. 

 
 
 
 

 

3 Double-click EtherCAT under 
Configurations and Setup in the 
Multiview Explorer.  

 

4 
The  icon for E001 is 

displayed on the Edit Pane.  
Confirm that the   mark which 
indicates normal communications of 
EtherCAT is displayed. 
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5 Select Troubleshooting from the 
Tools Menu.  

 

6 The Troubleshooting Dialog Box is 
displayed.  
Check that No Error is displayed in 
the Details Field in the Controller 
Errors Tab Page. 
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8. Initialization Method 
 
This document explains the setting procedure from the factory default setting.  
Some settings may not be applicable as described in this document unless you use the 
devices with the factory default setting.  
 

8.1. Initializing the Controller 
To initialize the settings of the Controller, select Clear All Memory from the Controller Menu of 
the Sysmac Studio. The Clear All Memory Dialog Box is displayed. Check the contents and 
click the OK Button.  
 

 

 
 

8.2. Initializing HMS Communicator 
For how to initialize HMS Communicator, refer to Section 4. Navigating the Anybus 
Configuration Manager of the User Manual Anybus (R) CommunicatorTM for EtherCAT (Cat. 
No. HMSI-168-95).  
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9. Revision History 
 

Revision 
code 

Date of revision Revision reason and revision page 

01 August 7, 2013 First edition 
02 March 3, 2014 Correction of device variable names for input area 

Correction of erroneous description 
03 September 9, 2014 Corrections due to the updates of Controller, Sysmac Studio, 

Communicator, and Anybus Configuration Manager. 
Change of ESI file due to Communicator upgrade. 
The procedure of "7.2. Setting Up HMS Communicator" is 
divided into "7.2.1. Hardware Settings “ and "7.2.2. Parameter 
Settings ". 
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